
 

 

 

Starter  

 

 

Getting Started Guide 



 

 

Contents 
Introduction...................................................................................... 1 

Installing and Licensing RM Easiteach................................................. 1 
Expand and Enhance your Use of RM Easiteach.................................... 1 

Key Features..................................................................................... 3 
Screen Menus ................................................................................. 3 

File ............................................................................................. 3 
Toolbars ...................................................................................... 3 
Resources .................................................................................... 4 
Multimedia Bank ........................................................................... 4 

Screen Tools................................................................................... 5 
Go to Previous/Next Page............................................................... 5 
Insert New Page ........................................................................... 5 
Switch Screen Tools ...................................................................... 5 
Hide/Show Keyboard ..................................................................... 5 
Calculator .................................................................................... 5 
Garbage ...................................................................................... 5 
Fade Screen with Spotlight ............................................................. 6 
View............................................................................................ 6 

Glass Mode ................................................................................ 7 
Split Screen ............................................................................... 8 
Storyboard ................................................................................ 8 

Handwriting Recognition ................................................................ 9 
The Easiteach Toolbar .................................................................... 10 

Use Mode................................................................................... 11 



 

 

Edit Mode .................................................................................. 11
Highlight.................................................................................... 11 
Pen ........................................................................................... 11 
Delete ....................................................................................... 11 
Lines ......................................................................................... 12 
Speak........................................................................................ 12 
Drawing Shapes.......................................................................... 12 
Fill ............................................................................................ 12 
Fill Color .................................................................................... 12 
Line Color and Width ................................................................... 12 
Undo; Redo................................................................................ 13 
Group/Ungroup........................................................................... 13 
Order ........................................................................................ 13 
Align ......................................................................................... 13 
Effects....................................................................................... 13 
Utilities...................................................................................... 14 
Voting and Polling ....................................................................... 16 

The Starter Toolbar ....................................................................... 19 
Math: Place Value Cards .............................................................. 20 
English Language Arts: Punctuation............................................... 21 
Science: Image capture tools........................................................ 22 
Geography: Navigator ................................................................. 23 

Tutorial: Starting an Easibook ........................................................... 24 
Adding Shapes .............................................................................. 25 
Changing the Color ........................................................................ 25 
Adding Text .................................................................................. 26 
Aligning Text and Group Selection ................................................... 27 



 

 

Formatting Text ............................................................................ 29
Grouping Items............................................................................. 29 
Adding an Image........................................................................... 30 
Locking ........................................................................................ 30 
Interactivity.................................................................................. 31 

Fill to Show ................................................................................ 31 
Drag to Reveal and Copying Objects .............................................. 31 
Resize to Reveal ......................................................................... 31 
Hide or Show on Click.................................................................. 32 

Further Reading ............................................................................ 32 



1 

 

Introduction 
Welcome to RM Easiteach. This software has been designed for use with interactive 
technologies, including all brands of interactive whiteboards. It can transform the 
classroom teaching and learning experience, and help you to deliver fast-paced, 
interactive and highly differentiated lessons.   

 

Installing and Licensing RM Easiteach 
See the RM Easiteach Installation Instructions leaflet in your RM Easiteach pack for the 
installation and licensing of RM Easiteach and Handwriting Recognition (where supplied), 
and for the installation of RM Easiteach onto networks. 

 

Expand and Enhance your Use of RM Easiteach 
RM Easiteach Subject Tool packs are available for Math, English Language Arts, Science 
and Geography. These are easy to use, flexible software equivalents of familiar teaching 
tools that you already use in the classroom: for example, place-value cards for Math, 
sentence builder cards for English Language Arts, map building tools for Geography and 
stopwatch and timer tools for Science. 

 

Lesson Content Packs are also available. Developed with teaching experts, they provide 
teachers with a wealth of prepared materials, all referenced to learning outcomes and 
objectives. Each activity has comprehensive teaching notes, vocabulary, objectives and 
suggestions for further work. They are highly visual and easy to modify and update to suit 
your needs. 
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For more details please contact your RM Easiteach distributor or visit 

www.rmeducation.com. 

 

 

www.rmeducation.com
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Key Features 
 

Screen Menus 
 
 File 

 
 
 

You can use the File menu to create and save files, open 
saved files, merge files, clear your page, print, change the 
screen appearance, get help and upgrade your license. 

• Select Open to browse to your saved RM Easiteach 
files.  Choose Examples… to display and use examples 
of Easiteach.  

• Select Change Appearance to alter the screen 
interface. You can choose between standard and 
graphic.  There is no difference in their functionality.  
The graphic interface has a more colorful appearance. 

• Select Whiteboard Calibration to calibrate your 
whiteboard using its own calibration tools. 

 

 

 

 

 
 

 

 

 

Toolbars 
The Toolbars menu displays your licensed tools.  They provide 
access to the range of RM Easiteach features determined by 
your license agreement. Click a tool to open the toolbar.  You 
can have any number of toolbars on your page. 
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 Resources 

 The Resources menu contains links to the Multimedia Bank 
and the Word Bank. 

 

 

 

 Multimedia Bank  

 

 

The Multimedia Bank contains a library of over 2000 
RM Easiteach images, photos and multimedia. 

 

 

 

Click Categories to view the menu. Images under the 
selected category are displayed in the Multimedia 
Bank window. 

To place an image on the 
page, simply drag it from the 
window to the required 
position. Its initial size can be 
set using the three buttons on 
the right. 

 

You can also access other images, photos and multimedia. Select Browse to navigate to 
files. Any images contained in a file are automatically found and displayed in the 
Multimedia Bank window. 
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Screen Tools 
 

 

Go to Previous/Next Page 
Move to the previous page or next page in your Easibook file. 
 

 

Insert New Page 
Add a new page to your Easibook after the current page. 
 

 

Switch Screen Tools 
Switch the screen tools to the opposite side of the page (ideal for configuring the tools 
for left-handed or right-handed users). 
 

 

Hide/Show Keyboard 
Turn the on-screen keyboard on and off.  When a caret is on screen, text is inserted at 
that position. 
 

Calculator 
 Display the on-screen calculator. 

 

Garbage 

 Drag objects to the garbage can to delete them. 
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Fade Screen with Spotlight 

When you are not using the interactive whiteboard during a lesson, click Fade Screen 
with Spotlight to darken it. This ensures that the students are not distracted by anything 
on the whiteboard. 

 

 

 • To spotlight part of the page, place and hold the 
pen or finger on the whiteboard.  You can move 
the pen around to spotlight text and objects in a 
particular order.   

 
 

 

• Tap the whiteboard to restore full view. 

 

 
View 

Select View to select a screen mode: Normal, Glass Mode, Split Screen or Storyboard.  
The default mode is Normal. 
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Glass Mode  
Selecting Glass Mode displays the Glass toolbar.  While you are working in RM Easiteach, 
Glass Mode lets you open another application (e.g. a Web browser), annotate the screen, 
and capture a snapshot for use in RM Easiteach.  

You can switch between using your application and making annotations in Glass Mode by 
clicking Annotate/Interact Mode.  You can then add text and objects over the top of 
your application.  Selecting Grab Screen or Grab Rectangle takes a snapshot.  Clicking 
Exit Glass Mode returns you to the RM Easiteach window to view your snapshots. 

 

 

 
 

 

  

 

     

 

 

Handwriting 
Use Handwriting 
tool 

Grab Rectangle  
Inserts selected area 
into RM Easiteach 

New Background 
Refreshes the 
background image 

Annotate/Interact Mode 
Switches between your 
application and making 
annotations in Glass Mode 

Grab Screen 
Takes a screenshot and 
inserts it into RM Easiteach 

Keyboard 
Opens a keyboard for typing 
on-screen 

Exit Glass Mode 
Returns you to RM Easiteach 

Clean Glass 

Garbage 
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Split Screen  
This displays two pages at the same time.  The page on the left is the one you had open 
before selecting Split Screen; the page on the right is the next page in the document.  To 
view a different page, click the pane you want to change and then use the page navigation 
buttons.  You can drag objects and text to copy them from one page to the other. 

 

Storyboard 
 

 

This displays all the pages in your Easibook on one 
screen.  You can change the page order, delete 
pages, and copy and paste using the Storyboard 
toolbar.  To change the page order, select and drag 
the pages into position.  A red line indicates the 
insertion point.  To delete a page, drag it to the 
Garbage. 
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 Handwriting Recognition 
 

Exit from 
Handwriting 
Recognition 

The handwriting tool allows you to write into an RM Easiteach document (or other 
application, if you are using Glass Mode) if you have compatible handwriting recognition 
software installed. Click the Handwriting Recognition button to open the Handwriting 
toolbar, and write some words on the screen.  The handwriting is automatically recognized 
and displayed as text. The Recognition Options button allows you to choose between 
three recognition options – numeric, cursive writing and printing.  

 

 

  

Backspace 
Deletes one character 
at a time 

Enter 
Moves the caret 
to the next line 

Recognition 
Options 

Recognize as 
Numeric Only 
Recognizes handwriting 
as numbers only 

Recognize as Non- 
Joined-Up Writing 
Recognizes printing script 
(single strokes) only 

Recognize as  
Joined-Up Writing 
The default option –  
recognizes cursive script 
(joined-up) strokes  
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The Easiteach Toolbar        

Lines 

Drawing Shapes 

Fill Color 

Zoom In 

Undo 

Cut 

Copy 

Paste 

Utilities 

 

  

Fill 

Speak 

Delete 

Highlight 

Use Mode 

Pen 

Edit Mode 

Line Color and Width 

Align 
 

Effects 

Voting and Polling 

Order 

Group/Ungroup 

Zoom Out 

Redo 
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Use Mode 
Use Mode provides the basic functions used when teaching a lesson.  When in Use Mode, 
you can move, stretch and rotate single objects.  You can also cut, copy and paste an 
object and move it behind or in front of other objects using Order. 
 

 

Edit Mode 
Edit Mode is used to enter text and numbers.  It also provides access to a range of editing 
functions used when creating lessons, such as grouping objects together, aligning objects 
and adding effects.  In Edit Mode, selected objects are outlined in red. 
 

 
Highlight 
Provides a highlighting pen in five colors to highlight text or other areas of the page. 
  

 

  

Pen 
Provides a quick, thick, smooth freehand line in four colors for writing and drawing on the 
whiteboard.  The multi-colored pen uses the current Line Color and Width. 

 

Delete
Select Delete and then click an object to remove it from the page. 
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Lines
Add arrowed, straight, freehand, and poly lines. 

 

 

Speak 
Read the selected paragraph or word aloud. For speech options see the Utilities toolbar. 
 

 

Drawing Shapes 
Add rectangles, ellipses, polygons and predefined shapes such as stars 
and speech bubbles. 

 

 

Fill 
Add the selected Fill Color to text, shapes and images. 
 

 

Fill Color 
Opens a palette of fill colors for text, shapes and images. 
 

 

Line Color and Width 
Opens a palette of line colors and widths, and outline colors and 
widths for shapes. 

 

 



13 

 

 

Undo; Redo 
Undo and redo as many actions as you like from your current session. 
 

 

Group/Ungroup 
Group together and ungroup two or more objects.  The button highlights when multiple 
objects are selected. 
 

 

Order 
Opens the Order toolbar. When objects overlap in the wrong order, select either 
Move Higher, Move Lower, Move to Top, or Move to Bottom, to change 
how they overlap. 
 

 

 

Align  

Opens the Layout window, allowing you to align a selection of 
objects. 
 

Effects 
Opens the Text effect or Graphics 
effect window for editing the 
appearance of text, shapes and 
images. 
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Utilities 
 

 
Links 

Link Text 
Frames 

 

 

                                 
 

 

 

 

Lock/Unlock to Background 
Lock selected text and graphics to the page background to prevent editing in error. 
To unlock an item, select Access Locked Items first. 

 

Access Locked Items 
Allow temporary access to items that have been locked to the page. 
 

 

Links 
Set up links to other documents or files, create animations and hyperlinks, and make 
objects hide or show when you click on them. 

Speech 
Options 

Spell Checker 

Object 
Lock/Unlock to 
Background Style 

Background 
Record 
Sound 

Create 
Text 
Frames 

Access 
Locked 
Items 

Create Text Frame 
Constrain text within a frame. 
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Link Text Frame 
Link different text frames, so that text flows between them. 
 

 

Speech Options 
Configure options for speaking words or paragraphs. 
 

 

Record Sound 
Record a sound for use in an Easibook. 
 

 

Background 
Set an image or a color to be the page background, or create a tile effect.  
 

Spell Checker 

 
Check the spelling of words on the current page, choose alternatives from a 
dictionary, and replace words; highlight spelling mistakes on the page. 
 

 

Object 
Change the properties of objects.  For example, you can make an object copy as it is 
dragged away and fix the size of an object. 
 

 
Style 
Apply text styles, edit existing styles and create new ones for the Easibook. 
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 Voting and Polling 

Use this tool to display the results of a student vote either as number of responses or in 
frequency tables and charts. You can use either individual handsets or the Easiteach Voter 
on-screen voting and polling keypad, which is accessed from the voting controls. For a list 
of currently supported voting and polling hardware, contact your RM Easiteach distributor 
or visit www.rmeducation.com. 

RM Easiteach does not install the software for sets of handsets - it is simply able to make 
use of them within an Easibook. Before beginning to use individual handsets, you must 
ensure the software from the equipment manufacturer has been installed and the 
handsets are working correctly outside of RM Easiteach. 

The first time you use a set of handsets with RM Easiteach, you must set them up so that 
RM Easiteach can detect them: 

 

 

1. Select Voting and Polling on the Easiteach toolbar to open the Voting palette. 
2. Click on Handsets… to view the Handsets palette. 
3. Click on Setup… to view the Easiteach voting setup window. 
4. Choose the type of handset you have from the list of supported handsets. 

o If you know where the handset receiver is connected, select the port from 
the drop-down list and go to step 6. 

o Alternatively click on Detect. This will prompt RM Easiteach to detect 
where the handsets are connected to your computer. 

5. Press any button on one of the handsets. This will be detected by RM Easiteach 
and handset information will be displayed. Click OK. 

6. Click Apply to save the settings and then click Exit to close the Easiteach voting 
setup window. 
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Your handsets are now ready. You can begin voting. 

 

7. To prepare the vote, select Voting and Polling on the Easiteach toolbar. This 
opens the Voting palette, if it is not already on-screen. Choose the Question 
Type (select multiple-choice letters or numbers, or free-choice numeric answers 
up to 7 digits), and set Responses to allow either multiple responses (where the 
answer is a sequence), first response, or last response (allowing a change of 
mind) to be collected. Click the Clock icon to display a timer. 

 
 

  
 

 

Multiple  
Use to put items in order, e.g. 
'Put these mountains in order of 
height, highest first'  

 

Voting Display 
Drag a voting display panel to 
your page.

Clock 
Click to show a timer on your 
voting display panel.

Handsets 
Displays the Handsets palette.  
Use the Handsets palette to give 
names to individual handsets, set 
them up, or deactivate them. 
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8. Type your question on the Easibook page, 
including any multiple-choice answers. 

 

 

 

9. Drag a voting display panel onto the page 
and click the green Start/Stop button to 
begin voting. The button turns red. 

10. If handsets are not available, click the 
Easiteach Voter button to display an on-
screen voting keypad. 

11. The voting panel displays the number of 
votes as they are received. If the vote has 
been set up with the Clock icon selected, the 
timer on the voting display panel counts up. 

12. Click the red Start/Stop button to stop the 
vote. 

 

13. When the vote is complete, you can analyse 
the results in a number of ways by selecting 
the chart and table options from the display 
on the right. 

 

 

Start/Stop 
Click to start and 
stop the vote  

Clear 
Clears the 
display for 
another 
vote 

Easiteach Voter 
Use this keypad 
for on-screen 
voting 

Review 
Displays 
who voted 
and how 

Percentage 
Toggles between 
number of votes 
and percentage 
 Table 

Displays results 
in a table 

Pie chart 

Bar chart 
 

14. To clear the voting results, select Clear. 
 

Each handset can only contribute a single vote. However, if you are using the on-screen 
voting keypad, you can collate the votes of several groups of students. To do this, save 
the Easibook file without clearing the current vote, and press Start to begin the next vote. 
The result will be added to the existing votes.  

 

 

You can have more than one voting display panel on your page at a time. To activate one 
of the panels for voting, click on it.  

Changes you make using the Voting palette will only apply to new voting panels. An 
existing voting panel on the screen cannot be changed. 
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The Starter Toolbar        

 

The Starter toolbar provides a sample of tools from some of the available RM Easiteach 
subject toolbars. 

 
 
 

Upgrade Options 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

To display the toolbar, select Easiteach Starter on the Toolbars menu. 

 
To find out more about the Subject Tools packs from which these tools were sampled, 
select the Upgrade Options button. 
 

 

 
 

Select Image Source 

Navigator 

Place Value Cards 

Punctuation 

Capture Image 
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Math: Place Value Cards 
Use these cards in numeracy teaching to demonstrate place value from 9,999,999 to 
0.0001. They snap together and move together, and you can color-code them to make the 
concept clear. 

Click the Place Value Cards button to display the palette for creating place value cards. 

 

 

                                                                            
 

Drag the number you want onto the page. Use the up and down arrows on the palette to 
display smaller or larger numbers. 

For more details see the RM Easiteach Maths Getting Started Guide, accessible from the 
RM Easiteach Help menu. 
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English Language Arts: Punctuation 
Use this tool to remove some or all of the punctuation from a text in RM Easiteach; then 
use it to add the punctuation. 

Click the Punctuation button to display the Punctuation Bank. 

 

 
 

When the Add tab is selected, you can add a punctuation symbol by dragging it into place. 

When the Remove tab is selected, you can remove all instances of a symbol by clicking it, 
or remove all punctuation, or remove all capital letters. These changes apply to all the text 
on the page, or any text you select. 

 

For more details see the RM Easiteach ELA Getting Started Guide, accessible from the 
RM Easiteach Help menu. 
 
 
 
 



22 

 

 
 

 

 

 

 

 

 

 

 

 
 

 

Science: Image capture tools 
Use these tools to capture and display digital images on an Easibook page.  

Click the Select Image Source button to display the Select Source dialog box. Select a 
TWAIN device, such as a digital microscope, camera or scanner, from the list. The device 
must be connected to your computer. Click Select. The Capture Image button is now 
enabled. 

 

 
 

Click the Capture Image button to display a dialog box for the device you selected. Click 
Capture to capture a digital image on your page. You can now move and resize the 
image. 

 

For more details see the RM Easiteach Science Getting Started Guide, accessible from the 
RM Easiteach Help menu. 
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Geography: Navigator 
Use the Navigator to place a green ‘locator’ on the page and move it around maps you 
have drawn or captured, using directions from a keypad. It is a very useful tool for 
understanding maps and teaching directions and navigation.  

  

 

 

 

 

 

Click the Navigator button to display the Navigator keypad and the locator. 

 

         

 

 

 

 

 

 

 

   
 

 

Use the direction buttons on the keypad to navigate around the 
screen. You can use the keypad’s controls to trace the locator’s path 
using a pen, to set its home position, and to record and replay its 
movements. 

 

 

 

 

For more details see the RM Easiteach Geography Getting Started Guide, accessible from 
the RM Easiteach Help menu. 
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Tutorial: Starting an Easibook 
In this tutorial you will create an interactive lesson activity as shown below. 
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If the Easiteach toolbar is not present, click Toolbars > Easiteach. The Easiteach 
toolbar is displayed. Use Mode is selected by default. When you are working on the page, 
you can drag toolbars and windows, by their blue headers, to any space on the page to 
keep your work area clear. 
 

 Adding Shapes 

 

1. Click the Rectangle for the Drawing Shapes menu and 
select Shapes. The Shapes window is displayed. 

 
 

 

 

 

2. Click the circle shape and drag it to the top left of the 
page. 

3. Repeat with four more circles, arranging them in an arc 
across the page. 

4. Click the speech bubble shape and drag it to the top right 
of the page. Pull on the edges of the speech bubble to 
make it larger. 

5. Close the Shapes window. 
 

 

 

 

Changing the Color 
1. Click the Fill Color button and then click yellow on the Fill 

Color palette. 
2. Click the Fill button and click each circle to fill it yellow. 
3. Click white on the Fill Color palette and click the speech 

bubble to fill it white. 
4. Click black on the Fill Color palette and then close it.  This 

prepares the color for the text. 
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Adding Text 
1. Click the Edit Mode button. If you need to use an on-screen keyboard, click the 

Keyboard button at the bottom of the screen. 

 

2. Click near the top left corner and type the title What is the 
rule? Do not worry about the position or formatting of the 
text at the moment. 

3. Click near each circle and type the numbers 1  2  4  7  11. 
4. Click near the speech bubble and type What number 

comes next? 
5. Click beneath each circle and type + 1  + 2  + 3  + 4. 
6. Click in the left hand corner and type The number you 

add increases each time by 1. 
7. Click below this line and type The next five numbers in 

the sequence are 
8. Click below that and type 16  22  29  37  46. 

 
 
 

 

 

9. Double-click the speech bubble text to select it (if you are 
working on a whiteboard, you can alternatively ‘lasso’ 
multiple objects in Edit Mode by tapping, holding and 
dragging the pen or finger). Hold the cursor over the 
selection outline until the sizing arrows appear, and then 
drag inwards so that the text breaks over two lines. 
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10. Repeat with the lines of text to the bottom left of the page. 
11. Click Use Mode and click and drag the text and numbers 

into position. 

 
 
 

 

 

 Aligning Text and Group Selection 

 

 

1. Click Edit Mode; then click the arrow at the base of the 
Easiteach toolbar to extend it. 

2. To select a group, double-click the title, and then right-
click the two lines of text and the number 16 on the left of 
the page. These items are now selected together.  
If you are working on a whiteboard, you can alternatively 
‘lasso’ multiple objects in Edit Mode by tapping, holding 
and dragging the pen or finger. 

3. Click the Align button to display the Layout window. 
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4. Click the Align to Left button on the Layout window. The 

selected items are aligned to the first item selected. Click 
outside the Layout window.   

 

 
 

 
5. Group select the two lines of text and the number 16 and 

click the Horizontal Equal Space button. The horizontal 
gaps between the three objects are equalised. Click 
outside the Layout window.  

 

 

6. Group-select the row of numbers from 16 to 46, and click the Vertical Equal Space 
and Align to Base buttons. The text and numbers are now evenly aligned. You can 
now close the Layout window. 

 
 

 
 



29 

 

 

 
Formatting Text 

 

1. Double-click the title on the page and click Effects to 
open the Text effect window. Type 24 in the Height box 
and click the B for bold. 

2. Group-select the numbers in the circles so that they can 
be formatted together. In the Text effect window, select 
36 in the Height box menu. Drag the numbers to center 
them in the circles again. 

 

 

 
3. Click the Color tab on the Text Effect window. 
4. Group-select the numbers outside the circles and click 

red on the Color tab. 
5. Drag the cursor over the number 1 in the first line of 

text, to select it. Click green on the Color tab. 

 

 
 

 

Grouping Items 
1. To group the speech bubble with its text, first select them both. Now click the 

Group/Ungroup button. It is highlighted, showing that the items are grouped. 
These items can now be moved together. 
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 Adding an Image 
1. Select Resources > Multimedia Bank from the 

bottom of the screen. The Multimedia Bank window 
opens. 

2. Click Categories to open the Categories menu and 
click Characters. The images appear in the 
Multimedia Bank window. 

3. Click the bee image and drag it onto the page. 
Position it under the speech bubble. You may need to 
adjust their positions slightly so they do not overlap. 

  

 

 

 

Locking 
1. You can lock objects to the page to avoid the content being edited by accident or 

disturbed when boxes are dragged. Press Ctrl A on the keyboard to highlight 
everything on the page and then click Utilities to open the Utilities toolbar. 

2. Click the Lock/Unlock to Background button. 
3. You can access the items at any time by clicking the Access Locked Items button 

on the Utilities toolbar. Do this now, to continue with the tutorial. 
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Interactivity 
Fill to Show 
1. Click Fill and the Fill Color yellow, and click the 11 in the yellow circle to hide it. 
2. To show the number, set the Fill Color to black before the activity begins. Click Fill, 

and click in the center of the circle. 

 

 

 

 

Drag to Reveal and Copying Objects 
1. Click Fill Color and select blue.   
2. Click Rectangle and click next to + 1. Drag the blue 

rectangle across and down to hide + 1. 
3. Click Edit Mode. Click the blue rectangle and Copy. 
4. Click the page next to +2 and then Paste.  Repeat for 

+ 3 and + 4. Drag the rectangles to cover the sums. 
5. To reveal the sums, select Use Mode and either drag 

the rectangles to the Garbage or click Delete on the 
toolbar and then on each rectangle. 

 

 

Resize to Reveal  

 
1. Click Fill Color and select purple.  
2. Click Rectangle and click next to 16. Drag the purple rectangle across and down to 

cover the numbers 16 to 46. 

 
3. To reveal the numbers one at a time, select Use Mode and resize the rectangle by 

pulling its left edge. 
 



32 

 

 Hide or Show on Click 
 

1. Click Fill Color and select dark green. 
2. Click Rectangle and drag a green rectangle over the 

green 1 in the first line of text. 
 3. Click Edit Mode, select the rectangle, and click the 

Utilities button to display the Utilities toolbar.  
4. Click Links on the Utilities toolbar and select the 

Animate tab.   

5. Click the Hide/Show on Click box.   
6. Select Use Mode. Click the green rectangle to hide 

it; click again to show it. Close the Utilities toolbar. 
 

Further Reading 
To get you started using RM Easiteach, there is a Starter Pack of 32 lessons designed by 
subject specialists in their field, together with 8 simulations, 2 games and 1 video. Each 
lesson includes comprehensive teachers’ notes, detailing the learning objectives, 
describing the interactions on each page, and providing ideas for extending the lesson and 
ways to review the learning objectives covered.  
To access these resources, click File > Open > Starter Pack. 
 

For instructions on how to use more advanced features of RM Easiteach Starter, download 
a free copy of Easiteach Tutorials and Practical Activities from www.rmeducation.com. 
 

RM Part Number: 17U-752 

RM Easiteach Starter Getting Started Guide (US English) v1. 
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